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1. Overview

1.1 What is Unity IAP for Xiaomi IAP
Unity IAP provides an easy way to integrate Xiaomi IAP with Unity.

1.2 Process of using Unity IAP

Please append “.mi” to your package name, e.g. “com.unity.mygame.mi”
a. Technical Integration

I. Onboarding to Unity

Il. Server side integration

[ll. Client side integration
b. Build and Submit APKs



2. Login & Purchase Flow

Unity IAP both supports the stand-alone game (without a game server) and online game

(with a game server).

2.1 Stand-alone login & purchase

In the ‘init SDK binding’ step, the Xiaomi appld, Xiaomi appKey (both of these
given by Xiaomi) and the Unity Client Id, Unity Client Key (both of these given by Unity,
see 2.1 Onboarding to Unity for details) will be used to initialize the Unity IAP SDK.

Since there is no game servers, the purchase should be validated on the client
side. Sample of the validation can be found in 2.3.5 Purchase Validation. After the
validation succeeds, the purchase can be completed.

The flow’s details are shown as below.
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2.2 Online login & purchase

Different from stand-alone flows, the game server can verify the login and receive
purchase order callback or initiatively query purchase order to/from the Unity IAP server
(the details of these APIs are shown in 2.2 Server side integration).

The flow’s details are shown as below.
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3. Technical Integration

3.1 Onboarding to Unity

Before integration can start, Game developer first needs to onboard to Unity IAP
and will obtain the following developer credentials (these keys are binding to the project
and bundle id):

Unity Client Id

Unity Client Key

Unity Client Secret

Unity RSA public key

Meanwhile, Game needs to provide the appld, appKey and appSecret offered by
Xiaomi, and a callback URL of the Game server (if there exists one) to receive order
status update.

Before going live, Game developer will also need to provide Game server IP

addresses to be whitelisted on Unity IAP’s production server.

3.2 Server side integration

Product environment: hitps://cn-api.unity.com

Debug environment: https://cn-api-debug.unity.com

Server sample code (Java) could be found at https://unitytech.github.io/channel/

server-sample-code, it contains verifying Xiaomi logins (see 2.2.1), checking order

status (see 2.2.2), signing request data, and verifying Unity IAP server callbacks.

3.2.1 Verify Xiaomi Logins


https://cn-api.unity.com/
https://unitytech.github.io/channel/server-sample-code
https://unitytech.github.io/channel/server-sample-code

GET
/v1/login-attempts/verifyLogin?

userLoginToken=<userLoginToken>&sign=<sign>

Parameters:

Attribute Name Required? | Description format | Sample
userLoginToken | Yes Unity user login | String eyJleHRIcm5hbEFw
toker_1 returned cElkljogljQwMzgwN
by client SDK . )
when finishing TUOMzkiLCAiZXh0Z
login XJuYWxUeXBlljoglk
ZBSOVDSEWILCAiZ
Xh0ZXJuYWxVaW
QiOiAIRKFLRUNITF
9seXhoaylsICJleHR
Icm5hbFNIc3Npb24i
OIAIRKFLRUNITFOT
RVNTSU90In0=
sign Yes md5 with String dc03e329e44c80b
userLoginToken
7 fd30207
and Unity Client 3d5bbfd30207de
Secret. Check 8f
the algorithm in
the end of the
doc
Response: in Json
Attribute Required? | Description Format Sample
Name
success Yes result of verify bool true




Xiaomi login

errMsg Yes the error String Invalid appld error
message of the
login if login failed

Sample:

Request:

GET

/v1/login-attempts/verifyLogin?
userLoginToken=eyJleHRIcm5hbEFwcEIlkljogljQwMzgwNTUOMzkiLCAiZXh0ZXJuYWxUeXBlIljog
IkZBSOVDSEWILCAIZXh0ZXJuYWxVaWQIiOiAiRKFLRUNITF9seXhoaylsICJleHRIcm5hbFNIc3Np
b24i0iAIRKFLRUNITFOTRVNTSU90IN0=&sign=ea24156d9c6fa3d527e99b9d644068ab

Response:

{

“success”: true

3.2.2 Check Order Status

GET
Iv1/order-attempts/query?cpOrderld=<cpOrderld>&clientld=<clientld>&orderQueryToken=<order

QueryToken>&sign=<sign>

Parameters:
Attribute Name | Required | Description Format Sample
?
cpOrderld Yes order id assigned | String 66mea52wne
by game , or




Unity if game will
not generate it

clientld Yes client id assigned | String Q4AnJDW2-r
by Unity after .
onboarding XLAPujgrk1z

Q

orderQueryToken | Yes order query token | String XIAOMI
returned by client
SDK when
finishing
purchase

sign Yes md5 with String 7277da780d1
cpOrderld, 102864ee581
clientld, 8c2730c74e
orderQueryToken
and Unity Client
Secret. Check
the algorithm in
the end of the
doc

Response: in Json

Attribute Required? | Description Format Sample

Name

id Yes orderAttemptid | String 27487794382
assigned by 6
Unity

clientld Yes client id returned | String Q4ANnJDW2-r
after Game .
onboarding to xLAPujarkiz
Unity IAP Q

cpOrderld Yes order id String 66mea52wne
assigned by

game , or Unity if
game will not
generate it




uid Yes user id assigned | String 15400813498
by Xiaomi
status Yes status of the String SUCCESS
orderAttempt
productld Yes product id of the | String Product_1
product
associated with
the orderAttempt
payFee Yes pay fee of this Integer 1
order (in channel
unit)
quantity Yes quantity of the Integer 1
product
notified Yes whether the Boolean No
orderAttempt’s
status is notified
to Game server
currency Yes currency ISO 4217 CNY
country Yes country ISO 3166-2 | CN
paidTime Yes orderAttempt 1ISO8601 2017-03-08T
paid time yyyy-MM-dd | 06:43:20Z
Thh:mm:ssX
XX, UTC
timezone
createdTime Yes orderAttempt ISO8601 2017-03-08T
created time yyyy-MM-dd | 06:43:20Z
Thh:mm:ssX
XX, UTC
timezone
updatedTime | Yes orderAttempt ISO8601 2017-03-08T
updated time yyyy-MM-dd | 06:43:20Z
Thh:mm:ssX
XX, UTC

timezone




createdBy Yes created by which | String 27487794382
user (only for 2
support use)

updatedBy Yes updated by String 0
which user (only
for support use)

rev Yes the revision of String 0
the orderAttempt
(only for update)
extension No extesion Json String {"abc" :
ll1 23"}
Sample:
Request:
GET

Iv1/order-attempts/query?cpOrderld=<66mea52wne>&clientld=<Q4AnJDW2-rxLAPujqrk1zQ>&or
derQueryToken=<eyJjaGFubmVsVHIwZSI61CJGQUtFQOhMIliwgImNoYW5uZWxVaWQiOiAiRKFL
RUNITF90eGQwWNSJ9>&sign=<debd0018911d263e23dfb729207b905¢c>

Response:
{
"createdBy" : "0",
"updatedBy" : "0",
"createdTime" : "2017-03-08T06:43:20Z7",
"updatedTime" : "2017-03-08T06:43:20Z",
"id" : "274877943826",
"userld" : "274877943822",
"status" : "SUCCESS",
"cpOrderld" : "66mea52wne",
"clientld" : "Q4AnJDW2-rxLAPujgrk1zQ",
"uid" : "15400813498",
"productld" : "Product_1",



"payFee"
"quantity”

1,
1,

"paidTime" : "2017-03-08T06:43:20Z",

"notified"

: false,

"currency" : "CNY",

"country"

"I"eV" ll1ll

: "CN",

3.2.3 OrderAttempt Callback Notification

Unity IAP server will notify the Game server with the order payment result.

Please implement the http GET and accept following query parameters.

Attribute Required? | Description Format
Name
signData Yes the order content which is in Json String
Json String format (details can
be seen in the table below)
signature Yes RSA signature with the String
signData. Check the algorithm in
the end of the doc
signData content:
Attribute Name [ Required? | Description Format Sample
orderAttemptld | Yes orderAttempt id String 27487794382
assigned by 6
Unity




status Yes status of the String SUCCESS
orderAttempt
productld Yes product id of the | String Product_1
product
associated with
the orderAttempt
quantity Yes quantity of the Integer 1
product
extension No extesion Json String {"abc" : "123"}
paidTime Yes orderAttempt yyyy-MM-ddT | 2017-03-08
paid time hh:mm:ssXXX | 06:43:20
, GMT+8
timezone
cpOrderld Yes order id String 66meab52wne
assigned by
Game
clientld Yes client id returned | String P-wUON9pbyQ
after Game TulksdkHX_Q
onboarding to
Unity IAP
country Yes currency String of ISO | CNY
4217
currency Yes country String of ISO | CN
3166-2
payFee Yes pay fee of this String 1
order (in channel
unit)
Response:

Please return "ok".

Enum types:

Or there will be retry natification in a time range.

1. status: SUCCESS, FAILED, UNCONFIRMED




Signature verification:
1. Api call:

Any api call to Unity IAP server should have the parameter of signature.

a
b. Use all the parameters to calculate the sign if they are not null or empty.

o

The parameters should be urlDecoded.

d. Sort the parameters by alphabet of the attribute names, and then concatenate
the attribute values with the delimiter of &, finaly append the app secret at the
end of the string to be signed

e. Do not use the sign in the sign string.

f.  Use md>5 to hash the string. Use the lower case result to verify sign

Example:

When there is a call look like:

GET

Iv1/login-attempts/verifyLogin?
userLoginToken=eyJleHRIcm5hbEFwcElkljogljQwMzgwNTUOMzkiLCAiZXh0ZXJuYWxUeXBIljog
IkZBSOVDSEWILCAIZXh0ZXJuYWxVaWQIiOiAiIRKFLRUNITF9seXhoaylsICJleHRIcm5hbFNIc3Np
b24i0iAIRKFLRUNITFOTRVNTSU90IN0=&sign=ea24156d9c6fa3d527e99b9d644068ab

Then the string to be signed is
eydleHRIcm5hbEFwcElkljogljQwMzgwNTUOMzkiLCAiZXh0ZXJuYWxUeXBlljoglkZBSOVDSEwiL
CAiZXh0ZXJuYWxVaWQiOiAiRKFLRUNITF9seXhoaylsICJleHRIcm5hbFNIc3Npb24i0iAiRKFLR
UNITFO9TRVNTSU90IN0=&{SECRET}

where {SECRET} is the Unity Client Secret returned after onboarding.

2. Callback:
When Unity IAP server gives the callback notification to Game server, it will will
use RSA signature for verification. Please use the Unity RSA public key returned after

onboarding to verify the signData with the signature.



3.3 Client side integration

Install the “UnityChannel + Xiaomi UnitylAP beta plugin” in the game project.

Look at the sample script in /Assets/Plugins/UnityPurchasing/script/IAPDemo.cs.

This is copied into the Unity game project when the UnitylAP plugin is installed.

See Getting Started with Unity IAP to enable the “In-App Purchasing Service” for

the project.

i3 Project : .

= script

To build APK for Xiaomi MiPay store (not Samsung GALAXY, or GooglePlay)
target the store with menu, “Window” -> “Unity IAP” -> “Android” -> “Target Xiaomi

MiPay”. This enables Xiaomi + UnityChannel Java SDK. Use this to target different
supported Android app stores, before creating an APK build.


https://docs.unity3d.com/Manual/UnityIAPSettingUp.html

window [T

Minimize 3 M [Testing - Android <OpenGL 4.1>
Zoom = Layout
Bring All to Front i Services
Unity IAP > Create |AP Button G0 to DashBoad

~ |AP Catalog
Layouts >

Android Target Amazon

Co!lab " " - Target Google Play
Unity Connect > Receipt Validation Obfuscator Target CloudMoolah
Screenshot . Target Samsung Galaxy Apps
Services %0 Target Xiaomi MiPay
5"‘_‘?"9 #1 Xiaomi (Unity Channel) >
Game 3#82

This is saved in a file:

[@rroec S

|Create'| (& )|-‘|\|*i

»  Favorites . Assets » Plugins » UnityPurchasing
B BillingMode

¥ I Assets = IAPProductCatalog
¥ i Plugins b 1 UlFakeStoreCanvas
v @l Android

il assets
¥ @l UnityPurchasing

" Resources
Wl scenes
> Bl script

© Inspector
| BillingMode @ #.
=

{"androidStore":"XiaomiMiPay", "unityChannelTestMode":"Debug"}

Below will show some code samples for how to use Unity IAP, all the details

could be found in the IAPDemo.cs

3.3.1 SDK Initialization

private |IUnityChannelExtensions m_UnityChannelExtensions;

public void Onlnitialized (IStoreController controller, IExtensionProvider extensions) {

m_UnityChannelExtensions = extensions.GetExtension<IUnityChannelExtensions> ();



3.3.2 SDK Binding

Action initializeUnitylap = () => {
/I Now we're ready to initialize Unity IAP.
UnityPurchasing.Initialize(YourlmplementationOflStoreListener, builder);

J3

Applnfo unityChannelAppinfo = new Applnfo();
/I Xiaomi appld

unityChannelApplinfo.appld = "abc123";

/I Xiaomi appKey
unityChannelApplnfo.appKey = "efg456";

/I UnityChannel Client Id
unityChannelApplnfo.clientld = "hij789";
/I'UnityChannel Client Key
unityChannelApplinfo.clientkey = "kim012";

unityChannelLoginHandler = new UnityChannelLoginHandler();
unityChannelLoginHandler.initializeFailedAction = (string message) => {
Debug.LogError("Failed to initialize and login to UnityChannel: " + message);
2
unityChannelLoginHandler.initializeSucceededAction = () => {
initializeUnitylap();
2
/I Please do below initializations in the Awake() method
StoreService.Initialize(unityChannelApplnfo, unityChannelLoginHandler);

3.3.3 SDK Login

/I The login succeeded callback will the userinfo as the parameter, in which:
/I string userlnfo.channel: the channel name, e.g. ‘XIAOMI’
/I string userInfo.userld: the channel name and the channel uid,
/I string userinfo.userLoginToken: Unity user login token used for server side ‘verifyLogin’ api
unityChannelLoginHandler.loginSucceededAction = (UserInfo userinfo) => {
m_IsLoggedIn = true;
/I get channel type (XIAOMI) by userinfo.channel
/I get channel uid by userinfo.userld

/I get user login token by userinfo.userLoginToken



2
unityChannelLoginHandler.loginFailedAction = (string message) => {
m_lIsLoggedIn = false;
Debug.LogError("Failed logging into UnityChannel. " + message);
I3

StoreService.Login(unityChannelLoginHandler);

3.3.4 Catalog Setting

On the menu, “Window” -> “Unity IAP” -> “|AP Catalog”. Set the product “ID”.
In the “Advanced” -> “Store ID Overrides”, set the product id in “XiaomiMiPay”. Note:

Default “XiaomiMiPay” value is the same as for product “ID”.

IAP Catalog 002
test.product 5
Required
Type:
¥ Advanced

Locale: [En_us t)
Title:
Description:

¥ Store ID Overrides
AppleAppStore
GooglePlay
SamsungApps
AmazonApps

MacAppStore

TizenStore
WinRT
MoolahAppStore

XiaomiMiPay | test.product.xiaomi |

» Google Configuration

» Apple Configuration

( Add Product |\~

Catalog Export App Store Export |
Apple SKU: [ A [ Apple Application Loader ]
( Google Play CSV ]

Xiaomi MiPay Catalog

Next, to use the IAP Catalog product list in the script of the game project, either:

a) Read the catalog file. Remove all calls to “builder.AddProduct(...)” in your copy of
IAPDemo.cs and replace that code with this code which will read the IAP
Catalog:
var catalog = ProductCatalog.LoadDefaultCatalog();



foreach (var product in catalog.allProducts) {
if (product.allStorelDs.Count > 0) {
var ids = new IDs();
foreach (var storelD in product.allStorelDs) {
ids.Add(storelD.id, storelD.store);

}

builder.AddProduct(product.id, product.type, ids);
}else {

builder.AddProduct(product.id, product.type);
}

Or:
b) Manually input each product in the catalog. Add calls to “builder.AddProduct(
... )" for each Product ID in IAP Catalog.

3.3.5 Purchase Validation

/I For stand-alone game, please use the ValidateReceipt api to validate purchase locally,

/I For online game, please get the orderQueryToken and validate purchase with server side api,
/I The callback of ValidateReceipt will take these parameters:
/I bool result: whether purchase succeeded, e.g. ‘true’
/I string signData: the order content which is in Json String format (details can be seen in the table below)
/I string signature: the RSA signature with the signData. Please use the Unity RSA public key to validate the
signData (details can be seen in the code sample below)
using Validate;
string publicKeyStr = "YourUnityPublicRSAKey";
public PurchaseProcessingResult ProcessPurchase(PurchaseEventArgs e) {
var unifiedReceipt = JsonUtility.FromJson<UnifiedReceipt>(e.purchasedProduct.receipt);
if (unifiedReceipt != null && !string.IsNullOrEmpty(unifiedReceipt.Payload)) {
var purchaseReceipt =
JsonUltility.FromJson<UnityChannelPurchaseReceipt>(unifiedReceipt.Payload);
/I get orderQueryToken
/I and pass it to your server then do validate on the server
var orderQueryToken = purchaseReceipt.orderQueryToken;
/I or do the validation locally by using ValidateReceipt
m_UnityChannelExtensions.ValidateReceipt(

purchaseReceipt.gameOrderld,



(bool result, string signData, string signature) => {
// validate the signData with signature and Unity RSA public key
Validator validator =
new Validator (Convert.FromBase64String(publicKeyStr));

bool passed = validator.Validate (signData, signature);

s

/Il The details of Validator
using System;
using System.Collections;
using System.Collections.Generic;
using LipingShare.LCLib.Asn1Processor;
using System.Security.Cryptography;
namespace Validate {
public class Validator {
private RSAKey key;
public Validator (byte[] rsaKey) {
try {
key = new RSAKey (rsaKey);
} catch(Exception ex) {

throw new Exception ("Invalid public key.");

}

public bool Validate(string signData, string signature) {
byte[] rawSignature = Convert.FromBase64String(signature);
byte[] rawSignData = System.Text.Encoding.UTF8.GetBytes(signData);
if (key.Verify (rawReceipt, rawSignData)) {
return true;

}

return false;

}
public class RSAKey {

public RSACryptoServiceProvider rsa { get; private set; }
public RSAKey(byte[] data) {
using (var stm = new System.lO.MemoryStream(data)) {

Asn1Parser parser = new Asn1Parser();



try {

parser.LoadData(stm);
} catch(Exception e) {

throw new Exception ("rsa load data exception");
}

try {
rsa = ParseNode(parser.RootNode);

} catch(Exception e) {

throw new Exception ("rsa init exception");

/I Public verification of a message
public bool Verify(byte[] message, byte[] signature) {
var shathash = new SHA1Managed();
var msgHash = shathash.ComputeHash(message);
return rsa.VerifyHash(msgHash, null, signature);
}
// Parses an DER encoded RSA public key:
/1t will only try to get the mod and the exponent
private RSACryptoServiceProvider ParseNode(Asn1Node n) {
if (n.Tag & Asn1Tag.TAG_MASK) == Asn1Tag.SEQUENCE
&& n.ChildNodeCount ==
&& (n.GetChildNode(0).Tag & Asn1Tag. TAG_MASK) == Asn1Tag.SEQUENCE
&& (n.GetChildNode(0).GetChildNode(0).Tag & Asn1Tag.TAG_MASK) ==
Asn1Tag.OBJECT_IDENTIFIER
&& n.GetChildNode(0).GetChildNode(0).GetDataStr(false) ==
"1.2.840.113549.1.1.1"
&& (n.GetChildNode(1).Tag & Asn1Tag.TAG_MASK) == Asn1Tag.BIT_STRING)
{
var seq = n.GetChildNode(1).GetChildNode(0);
if (seq.ChildNodeCount == 2) {
byte[] data = seq.GetChildNode(0).Data;
byte[] rawMod = new byte[data.Length - 1];
System.Array.Copy(data, 1, rawMod, O, data.Length - 1);
var modulus = System.Convert. ToBase64String(rawMod);
var exponent =
System.Convert. ToBase64String(seq.GetChildNode(1).Data);



var result = new RSACryptoServiceProvider ();
result.FromXmIString(ToXML(modulus, exponent));

return result;

}

throw new Exception ();

private string ToXML(string modulus, string exponent) {
return "<RSAKeyValue><Modulus>" + modulus + "</Modulus>" +

"<Exponent>" + exponent + "</Exponent></RSAKeyValue>";

signData content:

Attribute Name [ Required? | Description Format Sample

orderAttemptld | Yes orderAttempt id | String 27487794382
assigned by 6
Unity

status Yes status of the String SUCCESS
orderAttempt

productld Yes product id of the | String Product_1
product

associated with
the orderAttempt

quantity Yes quantity of the Integer 1
product
extension No extesion Json String {"abc" : "123"}
paidTime Yes orderAttempt yyyy-MM-dd 2017-03-08
paid time hh:mm:ss, 06:43:20
GMT+8
timezone

cpOrderld Yes order id String 66mea52wne




assigned by

Game
clientld Yes client id returned | String P-wUON9pbyQ
after Game Tulks4kHX_Q
onboarding to
Unity IAP
country Yes currency String of ISO | CNY
4217
currency Yes country String of ISO | CN
3166-2
payFee Yes pay fee of this String 1

order (in channel
unit)

3.3.6 Duplicate Purchasing

/I This feature is only supported in Unity 5.5 and higher version.

/' When user repeats purchasing a non-consumable they already own,

/I the PurchaseFailureReason will be set as Duplicate Transaction.

public void OnPurchaseFailed(Product item, PurchaseFailureReason r) {

if (PurchaseFailureReason.DuplicateTransaction ==r) {

}

/I do something for duplicate pruchasing

m_PurchaselnProgress = false;

Note:

Developers can use the product.available ToPurchase bool field to determine if a product

is available from the Store’s Product Catalog. This field does not indicate ownership.

Developers can use the product.hasReceipt bool immediately after purchasing to

determine if a product is owned by the user, but this field will be reset to false when the

user restarts the application. There is essentially no support for Product Inventory in

Unity IAP. Therefore developers need to implement their own persistent Inventory for

some purpose, such as, restoring transaction.










